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1. Introduction

This manual describes how to operate Field Wireless Device Restart Tool.

This tool is for restarting Yokogawa Electric field wireless devices that are compliant with

ISA100 Wireless™,

Notes
o

The information in this manual is subject to change without notice as a result of

continuing improvements in performance, functionality, etc. Furthermore, the screens

that are actually displayed may differ slightly from the screens displayed in this manual.

Every effort has been made to ensure the accuracy of the information in this manual,

but if you have any questions or notice any errors, please contact your nearest

Yokogawa regional office, branch office, or sales office.

Reprinting or reproduction of the information in this manual, in whole or in part, without

consent is prohibited.

The transfer or loan of the software to a third party is prohibited.

The information in this manual is for Field Wireless Device Restart Tool R1.01.01.

Terms and Abbreviations

Term

Description

Field Wireless Device

Restart Tool

Atool to restart field wireless devices.

Gateway Monitor Tool

A tool to manage field wireless devices.
YFGW410: FWMC Monitor
YFGW710: FWMT

EJX EJXoool series and EJXoooB series

YTA510 YTA510 temperature transmitter

YTMX580 YTMX580 multi-input temperature transmitter

FN310-J Field wireless multi-protocol module (HART communication)
FN310-M Field wireless multi-protocol module (digital communication)
FN510-DIDOAI FN510 field wireless multi-function module

FN510-ACAI FN510 field wireless multi-function module acceleration sensor input
FN910 Field wireless solenoid-valve control module

YOKOGAWA ¢
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1.1. “Field Wireless Device Restart Tool”
Software License Agreement

IMPORTANT - PLEASE READ THIS AGREEMENT CAREFULLY:

THIS SOFTWARE LICENSE AGREEMENT (“AGREEMENT”) IS A LEGALLY BINDING
CONTRACT BETWEEN THE END USER (“LICENSEE”) AND YOKOGAWA ELECTRIC
CORPORATION (*YOKOGAWA”) FOR LICENSEE TO INSTALL OR USE YOKOGAWA Field
Wireless Device Restart Tool SOFTWARE PRODUCT. BY INSTALLING, COPYING OR
OTHERWISE USING THE ENCLOSED SOFTWARE PRODUCT, LICENSEE AGREES TO
BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT.

IF LICENSEE DOES NOT AGREE, LICENCEE SHALL NOT INSTALL NOR USE THE
SOFTWARE PRODUCT.

1. Grant of License

(1) Subject to the terms and conditions of this Agreement, Yokogawa hereby grants to
Licensee a non-exclusive and non-transferable right to use the enclosed
“FieldWirelessDeviceRestartTool” and associated materials and documentation in printed or
electronic format (“Licensed Software”) free of charge.

(2) Licensee shall have the right to use the Licensed Software in the operating environment
identified by Yokogawa, either (a) to the extent specified in the contract specification agreed
upon by both parties, or (b) if not specified, for a single user on a single computer.

(3) Licensee may use the Licensed Software solely for its own internal data processing
operations to set up instruments having communication functions. Use of the Licensed
Software for any purpose other than those as expressly specified in the documentation
provided by Yokogawa shall be prohibited and any result or damage therefrom shall be at
Licensee’s own risk and responsibility

(4) Licensee may make one identical copy of the Licensed Software (in this context, excluding
any associated materials and documentation) for backup purpose, which shall be maintained
by Licensee with strict care. Such copy shall bear Yokogawa’'s proprietary notice as the
original does. No other copies shall be made without Yokogawa'’s prior written consent.

(5) In no event shall Licensee make any use of the Licensed Software in any other manner
than stipulated hereunder.
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2. Restriction

Licensee shall not: (a) remove any product identification, proprietary notices, or other
notices or restrictions from the Licensed Software; (b) transfer, sell, assign, sublicense or
otherwise convey the Licensed Software to another party without Yokogawa's written
consent; or (c) cause, permit or attempt the reverse engineering, disassembly, decompilation,
translation or adaptation of the Licensed Software. Any transfer of the Licensed Software is
subject to Yokogawa's transfer policies and fees.

3. Copyright / Ownership

The Licensed Software, including but not limited to any technology, algorithm, know-how,
process and others contained therein, is the proprietary property and trade secret of
Yokogawa or a third party who grant to Yokogawa the right of sub-licensing and is protected
by copyright and other intellectual property laws and treaties. Licensee acquires only the right
to use the Licensed Software and does not acquire any rights, expressed or implied, in the
Licensed Software or media containing the Licensed Software other than those specified in
this Agreement. Yokogawa shall at all times retain all rights, titles, and interests, including
intellectual property rights, in the Licensed Software and such media. The Licensee may not
disclose or divulge the aforesaid proprietary property and trade secret to any other individual
or entity than the Licensee’s personnel who reasonably need to know and the Licensee shall
impose strictly confidential obligations with respect to such proprietary property and trade

secret on such Licensee’s personnel.

4. Warranty / Liability

(1) THE LICENSED SOFTWARE SHALL BE PROVIDED TO LICENSEE ON AN “AS IS”
BASIS. TO THE MAXIMUM EXTENT PERMITTED BY LAW, UNLESS OTHERWISE
EXPRESSLY PROVIDED BY YOKOGAWA, YOKOGAWA HEREBY EXPRESSLY
DISCLAIMS ALL WARRANTIES OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING WITHOUT LIMITATION WARRANTY OF UNINTERRUPTED OR ERROR-
FREE OPERATION, NON-INFRINGEMENT, MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE OR NON-VIOLATION OF LAWS AND REGULATIONS THAT
APPLY TO OPERATION OF INSTRUMENTS BASED ON SETTING DATA CREATED BY
LICENSEE'S USE OF THE LICENSED SOFTWARE. SOME JURISDICTIONS DO NOT
ALLOW THE WAIVER OR EXCLUSION OF IMPLIED WARRANTIES SO THEY MAY NOT
APPLY TO LICENSEE. TO THE MAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT
SHALL YOKOGAWA BE LIABLE TO LICENSEE FOR ANY DAMAGE OR LOSS, WHETHER
DIRECT OR INDIRECT, ARISING OUT OF OR IN CONNECTION WITH BY THE USE OR
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INABILITY TO USE OF THE LICENSED SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH LOSS OR DAMAGE, WHETHER BASED IN WARRANTY
(EXPRESS OR IMPLIED), CONTRACT, STRICT LIABILITY, TORT (INCLUDING
NEGLIGENCE), OR ANY OTHER LEGAL OR EQUITABLE GROUNDS UNLESS
OTHERWISE IT IS CAUSED BY YOKOGAWA'S GROSS NEGLIGENCE OR WILLFUL
MISCONDUCT.

(2) THIS PARAGRAPH 4 STATES THE ENTIRE WARRANTY AND LIABILITY OF
YOKOGAWA IN CONNECTION WITH THE LICENSED SOFTWARE. THIS PARAGRAPH 4
ALLOCATES RISKS UNDER THIS AGREEMENT BETWEEN LICENSEE AND YOKOGAWA
AND COMPRISES FUNDAMENTAL ELEMENTS OF THIS LICENSE.

(3) LICENSEE SHALL INDEMNIFY, DEFEND AND HOLD HARMLESS YOKOGAWA FROM
ANY CLAIMS, DEMANDS, LIABILITIES, LOSSES, DAMAGES, JUDGMENTS OR
SETTLEMENTS, INCLUDING ALL REASONABLE COSTS AND EXPENSES RELATED
THERETO INCLUDING ATTORNEY’'S FEES, DIRECTLY OR INDIRECTLY RESULTING
FROM ANY CLAIM MADE OR POTENTIAL CLAIM BY A THIRD PARTY AGAINST
YOKOGAWA ARISING OUT OF ANY ACT OR USE OF LICENSED SOFTWARE BY
LICENSEE.

5. Term and Termination

(1) This Agreement shall become effective upon the Licensee installs, copies or otherwise
commences to use the Licensed Software and remain in full force until and terminate when
(a) Yokogawa terminates this Agreement according to paragraph 5 (2) or (3); or (b) the
Licensee actually ceases to use the Licensed Software, whichever comes earlier.

(2) Yokogawa shall have the right to immediately terminate this Agreement without any notice
to Licensee, if Licensee breaches any of the terms and conditions hereof.

(3) Yokogawa shall have the right to terminate this Agreement with or without cause at any
time by giving at least thirty (30) days' prior notice in writing or by electromagnetic means.
(4) Upon termination of this Agreement, Licensee shall immediately, in accordance with
instructions by Yokogawa, return all copies of the Licensed Software in its possession to
Yokogawa or its designee and erase all copies of the Licensed Software installed in any
computer hereunder.

(5) The provisions of the paragraphs 3, 4, 5 and 6 shall survive any expiration or termination

of this Agreement.
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6. General Provisions

(1) This Agreement shall be governed by and construed in accordance with the laws of Japan.
All disputes, controversies or differences which may arise between the parties hereto, out of
or in relation to or in connection with this Agreement shall be finally settled by arbitration in
Tokyo, Japan in accordance with the Commercial Arbitration Rules of the Japan Commercial
Arbitration Association. The award rendered by the arbitrator(s) shall be final and binding
upon the parties hereto.

(2) This Agreement shall supersede any prior representations, discussions, undertakings,
communications or advertising with respect to the Licensed Software.

(3) If any part of this Agreement is found void or unenforceable under any laws or regulations
and Yokogawa deems it is not reasonable to license without such void or unenforceable part,
Yokogawa is entitled to modify the terms of this Agreement or terminate this Agreement at its
option without owing any liability to Licensee.

(4) Licensee agrees that the Licensed Software shall not be shipped, transferred or exported
to any country or used in any manner prohibited by any export administration laws,
restrictions or regulations of Japan, the United States and other countries that may be
applicable to the Licensed Software.

(5) This English text shall be original and prevail translation versions in all respects.
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1.2. Positioning of This Tool

This tool is for restarting Yokogawa Electric field wireless devices. It can be run using either

of the two communication paths of via a gateway and via IrDA. When the target field wireless
devices are connected via a Yokogawa Electric gateway (YFGW410, YFGW710, or GX20W),

this tool allows you to restart them via the gateway without having to go to each location

where a field wireless device is installed. For cases other than that, this tool allows you to

restart the field wireless devices by connecting directly to them via IrDA.

The restart device function for restarting from the gateway monitor tool restarts only the

wireless communication module, but this tool restarts both the wireless communication

module and the sensor measurement module.

¢ When communicating via gateway

Software

Restart Tool

Field Wireless Device

ateway

G
((Yo kogawa) >

)

/ "o
I l a! ! &(Yokogawa)
B b o /
YTA510 EJX YTMX580 FN310-J FN310-M
-

Figure 1-1 Example of Configuration via Gateway
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e When communicating via IrDA

Use the tool via IrDA in cases such as when the field wireless devices are connected via
another company’s gateway or they are not connected to a gateway.

( ! ! (\(D\(?)\I/lggzwa) >

-

YTA510 EJX YTMX580 FN310-J FN310-M
\ b N b N * /4 Z o j
~ N / V2
IrDA ~. IrDA N IrDA // Ier\/ /IgDA/
N N N N / Vi 4 s -
~ N/ 7 <

i Software

Field Wireless Device
Restart Tool

Figure 1-2 Example of Configuration via IrDA

1.3. Software Operating Environment
The operating environment for this software is as follows.

® Supported operating systems
Operating Environment

Supported Windows 7 Professional, 32-bit

operating Windows 7 Professional, 64-bit

systems Windows 10 Professional, 32-bit
Windows 10 Professional, 64-bit

® .NET Framework

This tool is a Windows .NET application that runs in Microsoft .NET Framework.
Microsoft .NET Framework 4.6 or another compatible version must be installed.
.NET Framework 4.6 comes preinstalled in Windows 10. Please use that.

YOKOGAWA ¢ WLSG-19-014-EN 9/25



1.4. Infrared Adapter

To use the tool via IrDA, you need to obtain an infrared adapter and connect it to the PC.
The following infrared adapter is recommended. (Operation with other than the

recommended infrared adapter is not guaranteed.)

Product Name

ACT-IR224UN-LN96

Manufacturer

ACTISYS
http://www.actisys.com/IrDAProd.html
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2. Installation and Uninstallation

This chapter describes how to install Field Wireless Device Restart Tool.

Field Wireless Device Restart Tool does not have an installer. Extract the provided
compressed file and copy the resulting folder to any location.

To uninstall the tool, delete the folder.
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3. Operating Procedure

3.1. When Communicating via Gateway

1) Check that each of the field wireless devices is joined/published properly in the
gateway monitor tool in advance. In addition, when the gateway is the YFGW710,
write down the join count of the field wireless device for checking that the target field
wireless device has restarted (rejoined) at the end of the procedure.

* If the target device is used as “Router,” set “lO+Router.” When the device role is
“Router,” the applying of this process may fail.

2) Double-click the following exe file in the installed folder.
FieldWirelessDeviceRestartTool R1.01.01

— Field Wireless Device Restart Tool.exe

| = | FieldWirelessDevic... FFUT—23y Y=l - O X
i—Is kg F =3 v @
“ v « Tools » FieldWirelessD... v O FieldWirelessDevice... @
E2n] BEHHE &8 ¥
{£] ConnectionSetting.xml 2018/11/07 15:31 XML T7 )l
() Field Wirelss Device Restart Teol.exe 2019/11/05 108 FIUT-vay
IrDAComLib.dll 2019/ 1305 18:08 T3 VR
YGSAPLib.dll 2019/11/05 18:08 FIUr-avihE
Double-click
£ >
4EDEE 1EOESEER 60KB [E=

3) Select the gateway model (YFGW410 or YFGW710) to which to connect and enter
the IP address, and then click the [Connect] button. If there are many connected field
wireless devices, enter an arbitrary character string in “Device Tag Filter” and then
click the [Connect] button to display only field wireless devices including the entered
character string.

@ Field Wirelss Device Restart Tool - m} X
File(F)  Help(H)

|cateway  ~| vFGwato || 192 . 168 . 0 . 101 | Device Tag Filter [E)X | Comnect Click

[0 MNetworkID D< ceTag Model Device Role  "_164 Radio Firmware Sensor Firmware  Battery Life  Status

Device Restart
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4) The field wireless devices are displayed in order in the device list. Wait until “Connect
completed” appears for the tool status bar.

* |f you wish to change the character string in “Device Tag Filter” or stop the process,
“click the [Connect] button to disconnect without waiting for “Connect completed” to
appear and then perform the procedure from step 3.

File(F)

Help(H)

[cateway <] [vrowr10

-] 192 . 168 . Device Tag Filter EIX

Metwork ID  Device Ta

q Model Device Role  EUI-64 Radio Firmware Sensor Firmware  Battery Life  Status
[ 7007 |EIX_R25_w2 [Ex 10+Router | 0D00:64FF:FEAQ:06ES | RS.01.13 [R2.03.02 1666
7007 | EJX20_101 EIX 10+Router | 0022:FF00:0002:147E | YK__p4.02.24 R2.02.02 931
Connect completed -=5I
Check
5) Select the field wireless device to restart (multiple devices can be selected).
@ Field Wireless Device Restart Tool - m] X
File(F)  Help(H)
Network ID  Device Tag Model Device Role  EUI-64 Radio Firmware Sensor Firmware  Battery Life  Status
O 7007 [E}X_R25 w2 [E1x [10+Router | DD00:64FF:FEADIS6ES |RS.01.13 [R2.03.02 1663
=] 7007 | EX20_101 EIX I0+Router | 0022:FFO0:0002:147E | YK_p4.02.24  |R2.02.02 030
Connect completed
YOKOGAWA ¢ WLSG-19-014-EN 13/25



6) Click the [Device Restart] button.

° Field Wireless Device Restart Tool

File(F)  Help(H)

I [ 102 . 188 . 0 . 101 | Device Tag Filter [EIX \@

[J Network ID Device Tag Model Device Role  EUI-64 Radio Firmwara Sensor Firmware  Battery Life  Status
O] 7007 | EIX_R25_W2 [Ex |10+Router | 0000:64FF:FEAQ:96ED  |R5.01.13 [R2.03.02 1663
[ ] 7007 |EIX20_101 EX 10+Router |0022:FF00:0002:147E YK__p4.02.24 R2.02.02 930
Click /' [ Device Restart |
Connect completed
7) 1f “Device Role” of the selected field wireless device includes “IO+Router,” the
following confirmation dialog box appears. Click the [OK] button to continue.
Warning *
If the selected device works as a router,
the lower device may be disconnected.
Do you want to continue?
> oK Frotl
Click ( ) |
8) A confirmation dialog box appears. Click the [OK] button to execute.
Warning =
A Are you sure you want to restart?
: Ok s
Click Frotl
14/25
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9) Restart requests are sent successively to selected devices.
Check that the status becomes “Restart” as shown below.

* You cannot disconnect with the [Connect] button or exit the tool during execution of
this process. Wait until the process completes.

File(F)  Help(H)

IGateway -] IYFGW'JlD -] 192 . 168 . 0 . 101 | Device Tag Filter [ comeet |

MNetwork ID  Device Tag Model Device Role  EUI-64 Radio Firmware Sensor Firmware  Battery Life  Status
[ 7007 |E1X_R25_W2 [Ex I0+Router | 0000:64FF:FEAD:GBES  |R5.01.13 [r2.03.02 1666

7007 | EIX20_101 EIX 10+Router | 0022:FF00:0002:147E | YK__p4.02.24 R2.02.02 931 | Restart

10) To check that the field wireless device has restarted, check that the target device has
left the network in the gateway monitor tool.
* |f it did not leave the network, perform the procedure again from step 5 for that field
wireless device.

Example: When monitor tool in Field Wireless Management Console of YFGW410

HMoninor
File Tools Help

=2 4 du

b | |G

e [[] 7 HEE SN N 50 5
Dateandtime  2019/09/05 14:15:03--2019/11/08 15:11:59
Date and time Message
o 2019/11/08 15:11:59 admin logged in to the YFGWA10.
@ 2019/11/08 15:11:55 admin logged out of the YFGWA10.
o 2019/11/08 15:11:30 YFGW410 Link up on F1
'} 2019/11/08 15:1%:27 YFGW410 Link down on F1
L] 2019/11/08 15:11:26 YFGWA410 Link up on F1
) 2019/11/08 15:10:40 YFGW410 Link down on F1
o 2019/11/08 15:10:02 The security ger rejected D0O0:64F:feal:96e5 joining to the network.
(] MG/ 11708 150084 FINM 101 iminad bo the nstunrl
[@  201911/081507:20 £1X20 101 left the network.
|@ 2019/11/08 15:03:46 After publishing, the publication interval of L1X20_101 was beyond a Stale Limit.

Check that the target device has left the

network immediately after execution.
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Example: When Field Wireless Management Tool of YFGW710 (GX20W)

Action  View Help
SAF@ AR EWE
Network Topology * Network Health | Devices | [2]
Metwork Health information refreshed on: 2019/11/08 0:37:02 ({-480 seconds ago) Refresh
MetworkID: 7007 Devices Count: 12 StartDate:  2019/11/06 6:48:51 DPDUs Sent: 284323
Network Type: 0 Join Count: X} Current Date: 2019/11/08 0:37:02 DPDUslost: 15517
Network devices health information
Device Tag EUL-64 Address Start Date Current Date DPDUs Sent DPDUs Lost Join Count
YTMX580-PRVO0 L 0022:FF00:0002:577F 2019/11/06 8:25:03 2019/11/08 0:37:02 18139 1209 2
TA2G_027 0000:64FF:FESB:CODA 2019/11/06 8:46:30 2018/11/08 0:37:02 21731 4785 2
YFGW-BERO0L 0022:FF00:0002:0892 2019/11/06 6:49:06 2019/11/08 0:37:02 30848 0 1
XYR_6000_HLAI 0040:8400:0001:0334 2019/11/06 6:55:39 2019/11/08 0:37:02 17547 556 1
Ti02 0022:FFO0:0002:4D0E 2019/11/06 8:49:04 2018/11/08 0:37:02 20133 1459 2
FN910_ESDV1S 0000:64FF:FE9B:C1A5 2019/11/06 8:14:43 2019/11/08 0:37:02 18543 553 2 :
FNS10C_PP3 0000:64FF:FESB:C38C 2018/11/06 8:20:55 2018/11/08 0:37:02 20316 340 2
FN510A_DIDOAT_1 0000:64FF:FESB:C151 2018/11/06 8:17:48 2018/11/08 0:37:02 26458 515 2
FN310M_004 0000:64FF:FESB:CIES 2019/11/06 §:08:25 2019/11/08 0:37:02 18808 319 2
FN3101_001 0000:64FF:FESB:CI85 2019/11/06 8:11:38 2018/11/08 0:37:02 33715 485 2
EJ_R25_W2 0000:64FFFEAQ:96E9 2018/11/06 8:38:56 2018/11/08 0:37:02 20357 64 2
0022:FF00:0002: 147E

<

(@ Connected to 192.168.0.101 as admin (Administrator)

11) To exit the tool, click the [x] button on the title bar or select “Exit” from the File menu.

m [X] button on title bar

€ Field Wireless Device Restart Tocl
FilelF)  HelpiH)

RN | o - Profic USB-to-Serial Come Pest (COME)

:

| Network D Davica Tag

Mol

Davics Role  FLIL-64

Radio Firmware  Seneor Firmware  Battery Life  Status

Connect completed

YOKOGAWA ¢
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|10+Router | 0ODO:GAFF:FEAD:S6EG | RS.01.13
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|R2.03.02

552 | Restart
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m File menu - Exit

D Fiekd Wireless Device Festart Tool

Radio Firmware  Sensor Firmware  Battery Life  Status

Dewice Rode  EUIL-E4

[10+Router | 0000:64FF-FEAD:96EE  |RS.01.13 |r2.03.02 557 Restart

Connext completed

@ Are you sure you want to exit ?

| Hsz:rEn,]

YOKOGAWA ¢ WLSG-19-014-EN
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3.2. When Communicating via IrDA

1) Double-click the following exe file in the installed folder.

FieldWirelessDeviceRestartTool_R1.01.01

— Field Wireless Device Restart Tool.exe

[11 & [ = | FieldWirelessDevic.. - FFlsr—3% 9—)|
T = '

v @

£

4ENER 1EDESEER 620KE

- v |J, « Tools » FieldWirelessD... w FieldWirelessDevice... 0
-
&4l EFHEE =8 |
] ConnectionSetting.xml 2019/11/07 15:31 XML T741 L
@ Field Wirelss Device Restart Tool.exe 2019/11/05 1808 FIUT—3Y
IrDACemLib.dll 2019/11/05 18:08 FIT-vaviiE
[#] yGsAPLib.dl 2019/11/05 18:08 TFIr-y3 i

2) Select “Infrared” for the connection destination.

@ Field Wireless Device Restart Tool

File(F)  Help(H)

Device Role  EUI-64 Radio Firmware Sensor Firmware  Battery Life  Status

YOKOGAWA ¢ WLSG-19-014-EN
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3) Select the COM port, orient the infrared adapter toward the target field wireless device,
and click the [Connect] button.

@) Field Wireless Device Restart Tool

- [m] x
File(F)  Help(H)
P R [com - ESti— (coma) < | |[eonnece| ’
O Network ID Dew’oe‘ Model Device Role  EUI-64 Radio Firmware Sensor Firmware  Battery Life  Status
]

4) When a connection is established to the COM port, the [Connect] button turns blue and
information about the field wireless device appears.

@ Field Wireless Device Restart Tool - O b3
File(F)  Help(H)
_ |COME - Prolific USB-to-Serial Comm Port (COMS) v‘ [comnest_]
[ MNetwork ID Device Tag Model Device Role  EUI-64 Radio Firmware Sensor Firmware  Battery Life  Status
%} 456 | EJX_R25_W4 EIX 10+Router | DD00:64FF:FEAD:96E6 | R5.01.13 R2.03.02 552
Connect

5) Orient the infrared adapter toward the target field wireless device and click the [Start]
button.

@ Field Wireless Device Restart Tool - m} X
File()  Help(H)
_ ‘COMB - Prolific USB-to-Serial Comm Port (COM8) V‘ :l
[ MNetwork ID  Device Tag Model Device Role  EUI-64 Radio Firmware Sensor Firmware  Battery Life  Status
=] 456 | EIX_R25_W4 EIX I10+Router | 0000:64FF:FEAD:96E6  R5.01.13 R2.03.02 552
Connect completed Click /

YOKOGAWA ¢ WLSG-19-014-EN 19/25



6) If “Device Role” is “IO+Router,” the following confirmation dialog box appears. Click the
[OK] button to continue.

Warning

If the selected device works as a router,
the lower device may be disconnected.

Do you want to continue?

Click £roeh

7) A confirmation dialog box appears. Click the [OK] button to execute.

X

Warning
| Are you sure wou want to restart?
_ [ ok 1| #rven
Cligk

Pt

8) Check that the display for startup appears on the screen of the target field wireless
device immediately after execution. For the screen displayed at startup, refer to the
instruction manual for the corresponding field wireless device.

9) If the process ends successfully, the following dialog box appears. Click the [OK]

button.

YOKOGAWA ¢

o Device restart process completed,

Device Restart ot
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10) If you wish to execute the process for another field wireless device, click the [Connect]
button to disconnect and then perform the procedure again from step 4.

@) Field Wireless Device Restart Tool m] X
File(F)  Help(H} B
’ Click
_ |COME-ProIiﬁc USB-to-Serial Comm Port (COMS) - [ Cemnezt]
N
1 NetworkID Device Tag Model DeviceRole EU62  Radio Firmware  Sensor Firmware Battery Life  Status
] 456 |EJX_R25_W4 EIX I0+Router | 0000:64FF:FEAD:95ES R3.01.13 R2.03.02 552
Device Restart
Connect completed
11) To exit the tool, click the [x] button on the title bar or select “Exit” from the File menu.
m [X] button on title bar

&) Field Wirrless Device Restart Taol - 8] *

field)  Heplts /' O

m COME - Probic USB-to-Serial Comm Port (COME) - e C"Ck

[22 newerkio oevceTeg vodel Device Role  EUL-64 Radio Femware  Sensor Fimware | Battery Ufe  Stams |

A6 | ENCRIS_WA
Connect completed
m File menu - Exit
Model Device Role  EUI-64 Radio Firmware  Sensor Firmware  Battery Life  Status
10+Router | D000:64FF-FEAQ:9686  |R5.00.13 |R2.03.02 552  Restart
Device Restart
Connect completed
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The following dialog box appears. Click the [OK] button.

YOKOGAWA ¢

Tool exit

o Are you sure you want to exit 7

Frouh

WLSG-19-014-EN
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4. Appendix: Troubleshooting
Via Gateway

i. “Can’t connect” appears on the status bar
The connection with the gateway failed. Check the gateway selection, IP address, and cable

connection with the gateway, and then click the [Connect] button again.

@ Field Wireless Device Restart Tool - O X
File(F)  Help(H)

(Gateway  v||vFewst0 || 132 .168 . 0 . 101 | DeviceTag Filter [ connect |

[0 Network ID Device Tag Model Device Role  EUI-64 Radio Firmware Sensor Firmware  Battery Life  Status

Device Restart

Can't connect

Figure 4-1 Connection Failure Example

ii. “Communication error” appears for the status
This appears when communication with the field wireless device is not possible. The target
field wireless device may not be in the join/publish status. Check the network connection
status of the target field wireless device in a gateway monitor tool such as FWMC.
Click the [Connect] button to disconnect, check the join/publish status, and then reconnect.
* If you click the [Connect] button while the device is joined to the network, [*****] is displayed
for the network ID.

@) Field Wirelss Device Restart Tool - O x
File(F)  Help(H)

[Gateway ] [WFGW410 1 | 102 . 168 . 0 . 101 | Device Teg Fiter [ commect |
F Nefwork TD_ Device Tag Model Device Role  EUI-64 Radio Firmware Sensor Firmware  Battery Life  Status

O ruus | YTA2G_027 YTAS10 I0+Router | 0000:64FF:FE9B:CODA |R5.01.13 R2.03.02 Get device information
O 7000 | FN310]_001 Router 0000:64FF:FEQB:C3B5 |R1.07.07

O 7000 | FN310M_004 10 0000:64FF:FESB:CI1E6 |R1.07.07

O 7001 | T102 10+Router | 0022:FF00:0002:4D0E | YK__p4.02.24

] 7001 | YTMX580-PRV001 10 0022:FF00:0002:577F | YK__p4.02.24

] 7001 |EJX_R25_W2 10+Router | 0000:64FF:FEAD:96E9  |R5.01.13

] 7001 |FN510C_PP2 I0+Router | 0000:64FF:FE9B:C38C  |R1.07.07

O 7001 | FNS10_ESDV15 10 0000:64FF:FESB:C1A5 |R1.07.07

O 7001 | FN510A_DIDOAI_1 10+Router | 0000:64FF:FESB:C1B1 |R1.07.07

Device Restart

Figure 4-2 Information Acquisition Failure
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Via IrDA

iii. “Communication error” appears for the status
This appears when communication with the field wireless device you attempted to restart

fails. Check that the connected COM port is the infrared adapter and that the infrared adapter

is oriented toward the infrared receiver of the target device.

@ Field Wireless Device Restart Tool - ] X
File(F)  Help(H)

‘Infrar'ed v| ‘cor-u - e~ (COML) v| [ comect |

[] MNetwork ID Device Tag Model Device Role  EUI-64 Radio Firmware Senser Firmware  Battery Life  Status

Figure 4-3 Connection Failure

iv. “Restart error” appears for the status
This appears when communication with the field wireless device you attempted to restart

fails. Check that the infrared adapter is oriented toward the infrared receiver of the target
device.

@ Field Wireless Device Restart Tool — ] X

File(F)  Help(H)

COMS - Prolific USB-to-Serial Comm Port (COMS) | |connezen|

[ MNetweork ID  Device Tag Model Device Role  EUI-64 Radic Firmware Sensor Firmware  Battery Life  Status

Device Restart

Connect

Figure 4-4 Information Acquisition Failure
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Another Company’s Field Wireless Device
When the tool is connected to another company’s filed wireless device, display in the

device list will be gray as shown in Figure 4-5 and restarting with this tool will not be

possible.
@ Field Warcless Deviee Bestant Tel e (=] e
FlelF)  HelpiH)
|infrared | [coms - @@t~ P fcomy) Bl
||_—| Netwark [0 Device Tag Model Device Rele  EUL-64 madio Firmwane  Sensor Femwane | Battery Life  Stanss
3 Dl bl ol bl A ama R i

Mot Supparted Device

Figure 4-5 Another Company’s Field Wireless Device

YOKOGAWA ¢ WLSG-19-014-EN

25/25



	1. Introduction
	1.1. “Field Wireless Device Restart Tool”                 Software License Agreement
	1.2.  Positioning of This Tool
	1.3.  Software Operating Environment
	1.4. Infrared Adapter

	2. Installation and Uninstallation
	3. Operating Procedure
	3.1. When Communicating via Gateway
	3.2.  When Communicating via IrDA

	4. Appendix: Troubleshooting
	Via Gateway
	i. “Can’t connect” appears on the status bar
	ii. “Communication error” appears for the status

	Via IrDA
	iii. “Communication error” appears for the status
	iv. “Restart error” appears for the status

	Another Company’s Field Wireless Device


